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Introduction

* General Information

* Basics of Visualization
Getting Started

* QGetting Data into ParaView

« User Interface (Pipeline
Browser, Properties and
Information Tab, ...)

« Controlling the Camera
« Exercise | (Creating a Source)

« Exercise Il (Loading and
viewing Data)

Applying Filters
. Common Filters

«  Exercise lll (applying filters,
creating visualization
pipelines)

« Exercise IV (Streamlines,
Volume Rendering)

Color Maps

Multiple Views
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« Comparative View

« 2D Plots

« Exercise V (Plotting)
 Text Annotation
e Time in ParaView

e Exercise VI + VIl (Time
Dependent Data)

 Animations
* Exercise VI
* Visualizing Large Models
« ParaView on HPC Systems
« Python-Scripting
* Exercise VIl
* Plugins

e Documentation, Useful Links

This course is based on Kitware’s
Paraview Tutorial.
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What is ParaView?

Open-source data analysis and visualization application (two- and
three-dimensional data sets)

Built on top of VTK => provides a comprehensive suite of
visualization algorithms

Supports many different file formats for both loading and exporting
data sets.

Supported platforms: Linux, Windows, Mac
Processing Modes:

Stand-alone mode

Client server configuration

Batch

Available at JSC on HPC Systems JUWELS and JURECA-DC
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The History of ParaView
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2000: collaboration between Kitware Inc. and Los Alamos National

Laboratory, funding provided by the US Department of Energy ASCI
program

2002: first release of ParaView

September 2005 - May 2007: development of Paraview 3 by Kitware, Sandia
National Lab. and other partners

v" user interface more user friendly

v’ quantitative analysis framework
June 2013: ParaView 4

v more cohesive GUI controls

v" better multiblock interaction

v" In situ integration into simulation and other applications (Catalyst)
Recent Releases: (currently ParaView 5.10.0)

v" Since 5.6: brand-new rendering backend with OpenGL 3.2 features (big
change to the rendering infrastructure in ParaView’s lifetime) since

ParaView 5.0, e.g. new VR backend (multi screen 3D projection, VR
devices)

v" Since 5.9: Extractors

March 16/17, 2022 Folie 6



IJ JULICH

Forschungszentrum

Getting Started

ParaView can be downloaded at www.paraview.org
precompiled versions available for Mac OS,
Windows and Linux

sources for individual installations (e.g. using the mpi-
version tailored to your system)

ParaView client launches like most applications:
Windows: launcher located at the Start-Menu
Linux: execute paraview from a command prompt
Mac OS: open the application bundle that you installed
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ParaView‘s Architecture

ParaView ParaView
Client pvpython Web Catalyst | Custom App

Ul (Qt Widgets, Python Wrappings)

ParaView Server
VTK

OpenGL MPI lceT many more ...
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- concept of a visualization pipeline as implemented in VTK

Source Filter 1 Filter2

initial data modify the modify the
input or data in data in
generated some way some way

Mapper Actor Mapper Actor Mapper Actor

Gen'erates Adjust the Gen'erates Adjust the Gen.erates Adjust the
Function calls visible Function calls visible Function calls visible

to graphic . to graphic . to graphic :
ropert ropert ropert
system Properties system properties system properties

Renderer

Create images

of data

March 16/17, 2022 Folie 9



IJ JULICH

Forschungszentrum

Why use Paraview?

Free and actively supported by major DOE laboratories

Modular architecture => Separate processes possible for Data
processing, Rendering, User interface

Easy to use: all modes look the same (Stand alone, Client/Server)
Can handle large files
Built on VTK, which has a lot of more functionality

Drawbacks

Not 100% stable
Not well documented, in particular the internals
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Scientific Data

The data describes WHAT values are located WHERE.
Example: what temperature is at location (x, y, z) = (1, 3, 5)
WHERE: the structure of the data

1. Geometry: defines the (3D) location

2. Topology: describes the connectivity (neighborhood) of
points, defines which points form a cell

Example: three points at (x,,y1,21), (X,,Y5,2,), (X3,¥3,25) forming a
triangle

WHAT: the attributes (values) of the data, e.g. temperature,
pressure, ...

Typically the data is discrete (not continuous), given at a set of
points in 3D space.
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Data Types: Structured Data

Uniform Rectilinear Grid (Image Data)
(vtkimageData)

Non-uniform Rectilinear Grid (Rectilinear Grid)
(vtkRectilinearData)

Structured (Curvilinear) Grid
(vtkStructuredData)
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Data Types: Unstructured Data

Polygonal Mesh (Poly Data)
(vtkPolyData)

Unstructured Grid
(vtkUnstructuredGrid)

Multi-Block (several data sets grouped together)

Hierarchical Adaptive Mesh Refinement (AMR)
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Data Attributes

Data attributes at grid points (grid data, node data) or on cells
(cell data, element data):

General data attributes:
— Scalar
— Vector
— Tensor (nxn matrix)
Attributes with special meaning for the visualization process:
— Normals (3D vector)
— 2D or 3D texture coordinates
Any number of attributes can be defined at points and cells
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Supported Data File Formats

Some examples: -DEM files (.dem)
-ParaView files (.pvd) ‘VRML files (wrl)
‘VTK xml based files -PLY Polygonal files (.ply)
(vtp, Vti, wtr, wts, vtu) -Protein Data Bank files (.pdb)
-Parallel xml based VTK files -Xmol Molecule files (xyz)
(.pvtp, .pvti, .pvtr, .pvts, .pvtu) -Stereo Lithography files (_stl)
‘VTK MultiBlock -Gaussian Cube files (.cube)
(vtm, vtmb, vtmg, vthd, vthb) -Raw (binary) files (.raw)
-Legacy VTK files -AVS files (.inp)
(vtk for all types of data) ‘Meta Image files (mhd, .mha)
-Parallel legacy VTK files (.pvtk) -Facet files (facet)
-EnSight files (.case) -PNG files (.png)
-EnSight Master Server files (.sos) -LSDyna files (.d3plot, .k, .Isdyna)
-Exodus Il files -Phasta files (.pht)
(.g, .e, .ex2, .ex2v2, .exo, .gen, .exoll) -SESAME files (.sesame)
-BYU (.g) -Comma-separated values (CSV) files (.csv)

-XDMF files (.xmf, .xdmf)
-PLOT3D files (xyz, .q)
-SpyPlot CTH files (.spcth)

Full list at: https://www.paraview.org/Wiki/ParaView/Users_Guide/List_of_readers
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Input File Formats - VTK as an Example

VTK Family
(https://www.vtk.org/wp-content/uploads/2015/04/file-formats.pdf)
- Legacy serial (.vtk)

— polygonal, uniform, rectilinear, curvilinear, unstructured
* Legacy parallel

— same as legacy serial, but data is partitioned into several files
XML-based

— uniform (images, .vti)

—  rectiliniear (.vtr)

— curvilinear (.vts)

—  polygonal (.vtp)

— unstructured (.vtu)
XML-based parallel

— same as serial XML, but data is partitioned into several files
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Converting Data to VTK Format

Example on next slide: time dependent vector data on
structured grid

Converter to convert ascii data has to VTK XML was
implemented

VTK provides a number of source and writer classes to read
and write popular data file formats

In this example an XML file format of type
vtkStructuredGrid (. vts) was chosen

Result of converted data:

— xml file including the name of the dataset for each
timestep

— n datasets files, each including data of each timestep
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XML based StructuredGrid Fileformat: .vts

This is the description dataset, which lists the names of all existing
time datasets in an XML-based format

<?xml version="1.0"?2>
<VTKFile type="Collection" version="0.1" byte order="LittleEndian">
<Collection>

<DataSet timestep="50"group="" part="0" file =
"/private/sutmann/vts_Exercise 50.vts"/>

<DataSet timestep="100"group="" part="0" file =
"/private/sutmann/vts_Exercise 100.vts"/>

<DataSet timestep="150"group="" part="0" file =
"/private/sutmann/vts_Exercise 150.vts"/>

</Collection>
</VTKFile>
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¢) JiLicH
XML Data (first timestep) : vts_Exercise_50.vts

<?xml version="1.0"?>
<VTKFile type="StructuredGrid" version="0.1" byte order="LittleEndian">
<StructuredGrid WholeExtent="0 47 0 47 0 151">
<Piece Extent="0 47 0 47 0 151">
<PointData>
<DataArray type="Float32" Name="Velocity" NumberOfComponents="3" format="ascii">
-0.21008299291 -0.051097899675 -0.04968290031 0.16106699407 -0.065898902714 0.010098299943
0.10389400274 0.19959899783 -0.16598799825 0.15902400017 0.20383499563 -0.017544399947

</DataArray>
</PointData>
<CellData>
</CellData>
<Points>
<DataArray type="Float32" Name="Points" NumberOfComponents="3" format="ascii">
-48.916801453 -49.018299103 -149.00500488 -46.871700287 -48.936100006 -149.16099548
-44.773601532 -48.920101166 -149.07600403 -42.637401581 -48.958599091 -149.1734432

</DataArray>
</Points>
</Piece>
</StructuredGrid>
</VTKFile>
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HDF5

» Hierarchical data format: HDF5
- Efficient, portable |O library for storing scientific data
» High level of abstraction

« HDF5 is becoming a standard (even NetCDF is based on
HDF5)

- HDF5is a container for your specific data, not a standard data
format

BUT: HDF5 files do not contain meta-information needed for
visualization (semantics of datasets)

Solution: eXtensible Data Model and Format (XDMF)
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XDMF

Description of the meaning of HDF5 datasets, e.g. what data
defines geometry and topology, what data defines attributes

Small XML files (light data) in addition to (large) data files
(heavy data, typically HDF5)

Light data: XML file containing XDFM language statements
and references to datasets in heavy data

Heavy data: HDF5 files (or binary)

http://www.xdmf.org

March 16/17, 2022 Folie 21



IJ JULICH

Forschungszentrum

XDMF

How to generate XDMF files
1.  Write XDMF files by hand (its just a text file)

2. Add commands to write an additional XDMF file in your
existing I/0 procedures

3. Use XDMF API to write both light and heavy data
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XDMF Elements

Important XDMF elements are:

Grid: defines a single grid, an array or tree of grids, or a sub
set of another grid

Topology: defines the topology of structured and unstructured
grids (definition of “cells”)

Geometry: defines coordinates of node points

Attributes: defines values associated with the grid, node and
cell centered

Time: defines time values for a set of grids

Dataltem: the actual data, typically references to HDF5 or
binary data sets, but may also be directly defined in the XDFM
File. Also functions are possible in a Dataltem, e.g. to calculate
the magnitude of a vector on the fly.
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XDMF: Example for Structured Grid

<?xml version ="1.0" ?>
<!DOCTYPE xdmf SYSTEM "Xdmf.dtd" []>
<Xdmf Version="2.0">
<Domain>
<Grid Name="sphere" GridType="Uniform">
<Topology TopologyType="3DCoRectMesh" NumberOfElements="2048 2048 2048"/>
<Geometry GeometryType="ORIGIN DXDYDZzZ">
<Dataltem Dimensions="3" NumberType="Float" Precision="4" Format="XML">
-1024.000000 -1024.000000 -1024.000000
</Dataltem>
<Dataltem Dimensions="3" NumberType="Float" Precision="4" Format="XML">
1.000000 1.000000 1.000000
</Dataltem>
</Geometry>
<Attribute Name="distance" AttributeType="Scalar" Center="Node">

<Dataltem Dimensions="2048 2048 2048" NumberType="Float" Precision="4"
Format="HDF">

/viswork/hdf5Test/test 32768.h5:/sphere
</Dataltem>
</Attribute>
</Grid>
</Domain>
</Xdmf>
March 16/17, 2022 Folie 24
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XDMF: Example for Unstructured Grid (1/2)

<?xml version ="1.0" ?>

<!DOCTYPE xdmf SYSTEM "Xdmf.dtd" []>
<Xdmf Version="2.0">

<Domain>

<Grid Name="flow" GridType="Uniform">
<Topology TopologyType="Tetrahedron”" NumberOfElements="13340987">
<Dataltem Format="HDF" Dimensions="13340987 4">
out.h5:/flow Cells
</Dataltem>
</Topology>
<Geometry GeometryType="XYZ">
<Dataltem Format="HDF" NumberType="Float" Precision="8" Dimensions="2286605 3">
out.h5:/flow Points
</Dataltem>
</Geometry>
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XDMF: Example for Unstructured Grid (2/2)

<Attribute Name="u" AttributeType="Scalar" Center="Node" >
<Dataltem Format="HDF" NumberType="Float" Precision="8" Dimensions="2286605">
out.h5:/u
</Dataltem>
</Attribute>
<Attribute Name="v" AttributeType="Scalar" Center="Node" >
<Dataltem Format="HDF" NumberType="Float" Precision="8" Dimensions="2286605">
out.h5:/v
</Dataltem>
</Attribute>
<Attribute Name="w" AttributeType="Scalar" Center="Node" >
<Dataltem Format="HDF" NumberType="Float" Precision="8" Dimensions="2286605">
out.h5:/w
</Dataltem>
</Attribute>
<Attribute Name="p" AttributeType="Scalar" Center="Node" >
<Dataltem Format="HDF" NumberType="Float" Precision="8" Dimensions="2286605">
out.h5:/p
</Dataltem>
</Attribute>
</Grid>
</Domain>
</Xdmf>
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Programmable Source
Read your data with a programmable source filter

See:
https://www.paraview.org/Wiki/Python_Programmable_Filter

Programmable filters are programmed in Python

Example later ...
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User Interface

H paraview 5.9.0 — m} X
Menu Bar E File Edit Yiew Sources Filters Extractors Tools (Catalyst Macros Help
ERSELy PEO we FRZ HAPPMHE mp B, N
O R e S I Xxadbiduse? Fee -
Toolbars :> EVQEBRMESEL0 i Rl RERL &
Pipeline Browser utﬁl@ | +
ﬁbuilﬁn: =) o) : @
o 3
- Clipt
Pipeline Browser I:>
Properties | Informatior
. Properties @
Properties & iy | @t | o |2
I nfo r m at i 0 n Pa n e | .5‘55'::&; ij:; :;oi‘:‘ :EM_: unceck :aecne;u:_
| Face Blocks

Generate File Id Array

Toggle advanced ﬁ = therioy (mrirmiredts | @[ 2][
H Representation ks

properties: Mo ol .

Shows/hides additional [ -

s Edit e S

control parameter

B3 Aot

Menu Bar: access the majority of features Display Area
Toolbars: quick access to the most commonly used tools
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The Pipeline Browser

shows data readers and filters Ppelne Browser 8 x
. . . . . B buitin:
shows current visualization pipeline o Wi isidiog
structure @ @slcet
@& [ EStreamTracerl
allows you to » O
select objects within the current |

visualization pipeline
edit pipeline objects via the Properties Panel

concept of active objects:
 The selected object in the pipeline browser is the active object
* All changes within the GUI will refer on what is actually active

 The active object is used as the default object to use for
operations like adding a filter
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Properties Panel

Depends on the active s | ey | Ol et R
. . . . Representation e =

object in the pipeline iy e c;m [surf |
Properties SeCtion: Search ... {use Esc to dear text) [ 2y b ] IMagnjtJde i | [
various parameters of = roperes e | () (i) Lw:“’“ JECCMETY
the active object 5_"?*““ [P ") opay Ain

) . || Show Plane = sahts
Display section: orign o 0 e o —

. Mormal 0 0 1
appearance of the active | | e =
object (Representation, [ voma | i—f‘ i E“;
. == View (Render View) i
Color, Annotation, ...) { —— h ey b
View section: 7] Crinkle siice s batisn et
t. f the render [7] Triangulate the slice [¥] orientation Axes Visibility

p.roper €S 0 = Display (GeometryRepreseni Back_.grnurui
VleW (BaCkgrOU nd, Representation [Surface v] = [Gradlent v]
0 . t t. A ) |.Cdnr1 :v| [Resbcre Default]

rientation Axes, ... — S
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Apply/Reset

* changes to the object properties are not
immediately applied
» press Apply button to synchronize
your view with the parameters
« Same applies to opening a file:
* File -> open just reads the header
information of the file
« Hit the Apply button to load the data

IJ JULICH
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m | Information |

‘roperties

[ F apply ” () Reset |

use Esc to dear text]

== Properties (disk_out_ref.ex2)

[ Variables

V] fil Objectlds

| {fl Global Element Ids
[¥] 2% Global Node Ids

V] 3% Temp

Flsv

* Hitting the Reset button will restore the options back to the

last time they were applied.

March 16/17, 2022
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Information Tab:

. shows characteristics of the active |2 | m=m | 7=
object

¥

Data Hierarchy N
4 :Multi-block Dataset

- Dataset Type b EiimenBlicks
. Edge Blocks

- Number of Cells, Points Element Set

I Side Sets

- Data Arrays it

MNode Sets

m

Properties

Filename: disk_out_refex2
Path: Habbinga M ORK ParaViewkurs/Data/ParaviewTutorialData
Statistics

Type: Multi-block Datasst

Mumber of Cells: 7472

Mumber of Points: 8499

Memory: 2 MB =
Data Arrays
Current data time: 0

MName Data Type Data Ranges =

o AsH3 double [0.0804768, 0.184839]

e CH4 double [0, 0.00117024]

o GaMe3 double [0.000222844, 0.0072... |E

¢ GlobalMNodeld idtype [1, 8499] ‘

o H2 double [0.807613 0.917688] i
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Active Variable Controls, Representation Toolbar

Reset Scalar Range (Data Min/Max, Custom Range, All Timesteps, Visible Data)

e

‘ n i__al é i‘f_i ﬂ E:‘_,i—: E__?; o ¥ * | | Magnitudi ~ | Volume b
/ l Vect C¢ t
Edit Color Map ectoromponen
Toggle
Color Legend . Representation:
Mapped Variable Surface, Wire Frame,
Surface with Edges, Points,
Volume, ...

Can also be found in the display group of the properties panel!
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Display Area

probably most important part
shows results of the current visualization pipeline
various possible formats e

# Foa B B B m | RendeViewl ME]O)(x] ® ® ® G BarChartViewl [H)[E]@](X]

(2D and 3D views) -

Each display can be split v
vertically/horizontally

250

200

150

008 0.1 02 014 0le 08 0.2
B R RS LineChartview2 [)(B)[@)(X]

0.00714

—— CH4

0.00705

0,007+

0.00095

0.0009 -

(0.00085

0.0008 T T T 1
) 20 40 o8] B0 100
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Getting Data into ParaView

There are several methods loading data in ParaView:
- Reading data
- from a file (File - Open)
- command line argument --data=datafile
* Generate data from SOURCES Menu
- load a previously saved state file (File menu, Load State)

» this will return ParaView to its state at the time the file
was saved (loading data, applying filters, setting
preferences etc.)

* If you want to start a fresh visualization:
> reset ParaView with the Reset Session button: £}
» Edit -> Reset Session

March 16/17, 2022 Folie 35
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Controlling the camera

* Mouse interaction is mapped to camera movements as follows:

3D Interaction Options

Camera 3D Manipulators: Select how interactions are mapped to camera movements when in 30
interaction mode,

Left Button Middle Button Right Button
Rotate * || Pan ¥ || Zoom v |
Shift + | ol ~ || Rotate ~ || Pan -
Cirl + Zoom ¥ || Ro@Ete * || ZoomToMouse b

3D Mouse Wheel Factor: Set the wheel motion factor for 3D interaction,
L5

« Can be customized in the Edit -> Settings menu
« Camera Controls toolbar: < Z« o 28 &2 B2 28 20 &5 < 2

7 ] \U
Reset camera (all visible objects)

maintains view but repositions camera, to box axis Rotate camera
that entire objects are visible by 90 degree

<
/

Zoom Align view to coordinate

Zoom to data camera is
placed to look at data
March 16/17, 2022 (selected in pipeline browser) Folie 36
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Controlling the camera (continued)

. . . fra| "5 30 |"f.'|
Within the toolbar of each view: /"?/ \ T
Camera Camera Toggle3D/2D Adjust
. Undo Redo  Interaction  ¢a@mera
Adjust camera: Mode
« 4 custom (and more) views can be s |
po i Sg WP 1B ]} 3
stored and exported coson e
« Camera parameters (position, —F
view direction, view angle) can -
be set manually e am e
» Hint: if you want to rotate the —— (E TG e
camera around its position, open S e
Python shell and execute: e P
v = GetActiveView()
¢ = GetActiveCamera() =i (oo Bl o
v.CenterOfRotation=c.GetPosition()
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Controlling the camera (continued)

= Show/hide orientation axes at bottom-left corner of
the active view

]@| Show/hide axis drawn at the center of rotation
Set center of rotation to the center of the object

& Allows to pick the center of rotation
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Memory Inspector

Memory Inspector
* (@Gives overview about the -
memory footprint 4 B chent
— Total | BTG5 GiB 33.16% |
* In parallel mode, information L i 133.78 MIB 163% '
about client and server is given a || server
4 |nogeqy| SY5tem Total | ENEN 7] GiB 41.83% i
pyserver|d 548.80 MIB 3.44% |
[i] 520 (] 142.61 MiB 0.89% |
1 527 [ 135.72 MiB 0.85% |
2 528 (] 135.89 MIB 0.85% |
3 529 [’ 134.58 MiB 0.84% |
[¥] Auto-update
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Statistics Inspector

« Shows statistical information about all loaded data and filters
« Name
» Datatype
 Number of cells and points
* Memory consumption
* Spatial and temporal bounds

Sutistics Inspector . __ S ¢
$ __

Mame Data Type Mo. of Cells Mo, of Points Memory (ME) Geometry Size (ME) Spatial Bounds Temporal Bounds
disk_out_refe? % Multi-block Dat... @ 7472 < 499 1454 Unavailable (=575 575, 1w [{ALE]
Clipl % Multi-block Dat... @ 4218 o 5064 D488 0,174 [0, 5757, [=57.. j[ALE]
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Exercise I: Creating a Source

1. Select a Sphere from the Source Menu
— Show it ina 3D view and increase it’s resolution

— Experiment with dragging different mouse buttons within
the view (try also shift, ctrl)

2. (Delete the pipeline) Select a text from the Source Menu
— Additionally take a 3D text from the Source Menu
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Exercise ll: Loading and viewing Data

1. Open Open disk_out_ref.ex2

Select all variables, press “Apply”
Select variable V for the coloring

Try the different representation styles, finally choose
surface with edges

Turn the opacity value to 0.25
Save the actual state in a ParaView state file.

2. Experiment with the Center of Rotation:

March 16/17, 2022

Show/Hide it
Pick another Center (try some camera movements)

Reset the Center Of Rotation
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Applying Filters

Achievements so far:
* Load the data, glean some information about it

* See the structure of the mesh, map some attribute data on its
surface

But! Many interesting features cannot be determined by just
looking at the original data

» Discover much more about the data applying filters!
» Extract or generate new features from the data

* filters are attached to readers, sources, or other filters to
modify its data in some way.

» Most common filters are available in the filters toolbar:

190 BRVRTOEL
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Calculations within ParaView

Calculator: calculates new attributes based @‘3‘ QRS2 O
on simple expression e &
= example: ,LANDMASK*(abs(HGT) + 20.0)“ e e
. | = Properties {Calculator 1) H:| |:|
= (Can generate vectors from scalars via - =t
LiHat*velocity_x + jHat*velocity_y + kHat*velocity_z“ o
i e
= (Can generate new coordinates ‘%I%“I‘{%%}ﬁ
= Unflexibel, no ,,if* statement |t N — ‘__vl
b Display (GeometryRepresentation) (2] [=]
[ vev i v Bl&
PythonCalculator: calculates new attributes based
. . Properties =&
on simple Python expression -
=  NumPy and SciPy functions can be used — Sras"
= Properties (PythonCalculatord) BB e|a
= (Can generate vectors from scalars via Expressicm. _ _‘L].P-ointData['RAIN_Accumulated']‘ 0.0), 100.0)
~,make_vector (velocity_x, velocity_y, velocity_z)” gL == :
= No,,if statement, but numpy.where works, e.g. G ED

~,numpy.where(Rain > 20, -1 * Rain, LANDMASK*(numpy.abs(HGT)+20))“

Programmable Source/Filter
= Most flexible
= Needs some deeper knowledge of ParaView conventions and data flow
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Common Filters: Contour
PRPOESE 200

Properties Information

e 5 x _
S . » Extracts the points, curves, or
| Fooply || @reset || Mpdete [[L..B. ] T
———— surfaces where a scalar field is
— roneres Comour D) equal to a user-defined value.
Contour By [ o Temp -| <+ This surface is often also called
i e an isosurface
| | Compute Gradients

[7] Compute Scalars

[¥] Generate Triangles
Isosurfaces

Value Range: [293.15, 913.15]

1 42
5P Display (GeometryRepresentation)
gR View (Render View)
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Common Filters: Clip

Properties Information

W T T
Search .., (use Esc to dear text)

= Properties (Clip1)
Clip Type Plane b ]
Show Plane

Origin  0,3498991852221%%  0.159987747723768  0.758396381080340

Mormal -0,57001778548227  0,223385856271723  -0.790582289830522

[ === ]

[ Camera Normal I Center on Bounds ]
[7] Inside Out

[] crinkle dip

gh Display (UnstructuredGridRepresentation)

gh iew (Render View)

March 16/17, 2022
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. @ @ @ ﬁ @ ; £

Intersects the geometry with a
user-defined plane, box or
sphere

Removes all the geometry on
one side of this plane (box,
sphere)
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Common Filters: Slice

| Properties Information

Properties 8 X
T T T e
Search .., {use Esc to dear text) EE?J‘

=3 Properties {Slice1)

Slice Type Plane

[¥] sShow Plane

Origin  0,348030680617293  0,5952638700433598

-0,100052940 254971

Mormal 0,473996659300374  -0.41018080111483

0.779152666273491

[ X Normal I Reset Bounds )
[ ¥ Normal |

[ ZNormal ]

[ Camera Mormal ][ Center on Bounds ]
[ Crinkle slice

Triangulate the slice

gp Display (GeometryRepresentation)

g View (Render View)
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B9 PO 2O

Intersects the geometry with a
plane, box, sphere or cylinder

Similar to clipping, except that
all that remains is the geometry
where the plane is located.
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Common Filters: Threshold

Properties | information | | » Extracts cells that lie within a

Properties g X . pe .
. = = specified range of a scalar field
| & Apply || @ Reset [ % Delete ][ 2 ]
-Search .+ (Use Esc to dear text) qﬂ;—
== Properties (Threshold 1)
Scalars | o hardyglobal -
Mirimum B 3.92407
Maximum D 5. 88955
all Scalars

[ Use Continuous Cell Range

8P Display (UnstructuredGridRepresentation)
gP View (Render View)
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Common Filters: Extract Subset
EOCPS%

* Extracts a subset of a grid by
defining a volume of interest
and a sampling rate

=2® %

Properties Information

Properties

[ Fowoy |[ @reset (LDt Jl?

Search ... (Use Esc 1o dear text)

)
Hel

= Properties (Extractsubset1)

vol 0

0
0 0
0 20

sample Rate 1

sample Rate 1 ¢

Sample Rate K |

[ Indude Boundary
R Display (GeometryRepresentation) @
gF View (Render View) @
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Common Filters: Glyph

 Properties | Information | Go
Properties g X

ey | o= [ moeee || 2| ° Placesaglyph, a simple shape,
Search .., (use Escto dear text) @ On eaCh p0|nt (OI’ SU bset) |n a

== Properties (Giyphi) mesh

Glyph Source . i

e — 5 glyphs may be oriented by a
Active Attributes vector and scaled by a vector or
Scalors [ Temp z scalar.

Veectors ['u' ']

Orientation

[¥] Crient

Scaling

Scale Mode luﬂ= TI

Scale Factor | D 1.85472

Masking

Glyph Mode [E".-'n.=-_r1,,|I Mth Point ']

Stride 10

gn Display (GeometryRepresentation)

8 @
o [

g View (Render View)
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Common Filters: Stream Tracer

Properties 8 X

o s | mee | o= |2 || e Seeds avector field with points
Search ... {use Esc to dear text) G_ﬁ;:‘ and then traces those Seed

= Propertes (Streantracer points through the (steady state)
Vectors (v - | ;

vector field.

Integration Parameters
Integration Direction [m v,]
Integrator Type  [Runge-Kutta 4-5 x|
Streamline Parameters
[‘;ﬂ"ﬁi‘:’m Sheanioe [] 20.15000084741211 [
Seeds
Seed Type |Paint Source -
Shaow Paint | Center on Bounds ]
Point 0 0 0.0799999237060547
Number of Paints 100 =
Radius 2,01599998474121

gF D-iq':lay (GeometryRepresentation)

gF View (Render View)
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Common Filters: Warp (vector)

LTI O ¥

Properties Information

properties #x « Displaces each pointin a mesh
[ ooy |[ @reset (LMoot J 2] by a given vector field.
Search .., {use Esc to dear text)
=2 Properties (WarpByVector1)
Vectors  |grad =)
Scale Factor 3

5P Display (GeometryRepresentation)
BF View (Render View)
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Common Filters: Group Datasets
s sy EO0B89O=40)

ﬁbuilt’rﬂ:
@ Cyindert « Combines the output of several

@GruupDaEsetsl . . . . .
@ Conet pipeline objects into a single

& GroupDatasets1 multi block data set
CGroupDetacetsi |

Properties Information

Properties & x
| Faody || @reset |[ Mo [ 2 ]

Search .., (use Escto dear text)
== Properties (GroupDatasets1) @

5P Display (GeometryRepresentation)
5P View (Render View)

8 86608 8
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Filter Menu:

Many more filters in the

Filters Menu

—
Search...

Recent

AMR

CTH

Common

Data Analysis
Material Analysis
Quadrature Points
Statistics
Temporal

Alphabetical

Ctrl+5Space
3

b

Calculator

Extract Selection
Histogram
Integrate Variables

Plot Data

Plot Global Variables Over Time

Plot On Intersection Curves

Plot On Sorted Lines

Plot Ower Line

Plot Selection Owver Time n

Probe Location

Programmakble Filter

* |ists of all filters available in :

ParaView (Alphabetical)
« state of the entries

(enabled/disabled) depends on the

current data set’s type

Block Scalars
Calculator

Cell Centers

Cell Data to Point Data
Clean

Clean Cells to Grid
Clean to Grid

Clip
Clip Closed Surface
Clip Generic Dataset

Compute Derivatives
Connectivity

Contingency Statistics
Contour

Contour Generic Dataset
Convert AMR dataset to Multi-block
Curvature

D3

Decimate

Delaunay 20

Delaunay 3D

Descriptive Statistics

Elevation

Extract AMR Blocks

Extract Block

Extract CTH Parts

Extract Cells By Region

Extract Edges

Extract Generic Dataset Surface

Extract Level

Extract Selection
Extract Subset
Extract Surface

FFT Of Selection Over Time

Feature Edges
Gaussian Resampling
Generate Ids

Generate Quadrature Points

Generate Quadrsture Scheme Dictionary

Generate Surface Normals

Glyph

Glyph With Custom Source
Gradient

Gradient Of Unstructured DataSet
Grid Cannectivity

Group Datasets

Histogram

Image Data To AMR
Image Data to Poirt Set

Integrate Variables

Interpolate to Quadrature Points

Linear Extrusion

Loop Subdivision
Mask Points

Material Interface Filter
Median

Merge Blocks

Mesh Quality
Multicorrelative Statistics
Normal Glyphs

Octree Depth Limit

Octree Deptt
Outline
Outline Corners

Outline Curvilinear DataSet

4

ParticlePath
ParticleTracer

Pass Arrays

Plot Data

Plot Global Variables Over Time
Plot On Intersection Curves
Plot On Sorted Lines

" Plot Over Line

Plot Selection Over Time
Point Data to Cell Data
Principal Component Analysis

Probe Location

Process 1d Scalars
Programmable Filter

Python Annotation

Python Calculator

Quadric Clustering

Random Attributes

Random Vectors

Rectifinear Data to Point Set
Rectilinear Grid Connectivity
Reflect

Resample AMR

Resample With Dataset

Ribbon

Retational Extrusion

Scatter Plot

Shrink

Slice

Slice (demand-driven-compasite)

Slice AM

Slice Ge
Smooth
Streakline

Stream Tracer

Stream Tracer For Generic D
Stream Tracer With Custom Source
Subdivide

Surface Flow

Surface Vectors

JULICH

Forschungszentrum

Table To Points

Table To §
Temporal Cache

Temporal Interpolator
Temporal Particles To Pathlines
Temporal Shift Scale

Ternporal Snap-to-Time-Step
Temporal Statistics

Tensor Glyph

Tessellate

Tetrahedralize

Texture Map to Cylinder
Texture Map to Plane

Texture Map to Sphere
Threshold

Transform

Triangle Strips

Triangulate

Tube

Warp By Scalar

Warp By Vector

Youngs Material Interface

« See https://www.paraview.org/Wiki/ParaView/Users_Guide/List_of _filters
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Exercise lll:
Applying filters, creating Visualization Pipelines
1. Applying Filters

—  Open the file: disk_out_ref.ex2

— Add a Contour Filter, select variable
Temp and set the isosurface value to 400

— Use variable V to color data
—  View the data as a wireframe and the
contour as an isosurface

2. Creating Visualization Pipelines
—  Add (to the original data) an additional
Extract surface filter (see: Filter - alphabetical)
—  Create a Clip filter to Extract surface filter
—  Make Contour and Clip visible

March 16/17, 2022 Folie 55



IJ JULICH

Forschungszentrum

Exercise IV: Streamlines, Volume Rendering

1. Vector Visualization: Streamlines

March 16/17, 2022

Open the file: disk_out_ref.ex2

Select a Stream Tracer Filter, Add a tube filter

Add a glyph filter to the Stream Tracer Filter.

Set Vectors to V, show the glyphs as cones and color them with
variable Temp

Play with the glyphs parameters until the result pleases you

Fipeling Browser B X
ﬁli builtin:

& ﬁdisk_uut_ref.exz

- B éSteamTramrl
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Exercise IV: Streamlines, Volume Rendering

2. Volume Rendering

— Inprevious example:
Change the representation of the input data to Volume

— make the input data visible,
— Choose Temp for the coloring and make color legend visible

1

B builtin:
b *disk_uut_ref.exz
@ ‘StreamTraceH

@ B Tubet
@
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Changing the color map

*Via Color Map Editor (View->Color Map Editor, )

MW Preset Color Scales |EHEI

» ParaView provides a number of - —
preset color scales =P
|-—| Grayscale RGB

» To add another color/value pair to the mapping function
(double-)click into the gradient bar e R 7
(or add it manually into the table underneath)

* (Double-)click into the graph to modify the opacity transfer
function.
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Multiple Views

Achievements so far:

IJ JULICH
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* Coloring with one variable, extract iso surfaces with another

one, streamlines ..

But: still difficult to make correlations
between the variables!
» Use Multiple Views!

« Each view can show an
independent aspect of the data

« 2D (e.g. histograms, line charts,
spreadsheets ...) and 3D views are
possible

March 16/17, 2022

EILayout#lx ‘
B B R G Rendervewd @EEIRE) F 60 WA w0 s Rendeven2 DEE]E)

=] BarChartviewl [M]B][E]x] & & ™R LineChartview2 (I](H](3][x]

Ae+000 3500+
| I oin_vailuss
3.5e+006

3000+

2500

2000

500+
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Multiple Views

* Multiview is not limited to only two views

« Each view has its own set of multiview buttons ZEEX
to split horizontally/vertically or erase the view:

The view with the blue border is the active view

» The display and view parameters in the Properties Panel
depend on the active view (and on the selected item in the
Pipeline Browser).

The views can be changed in size by clicking in the space
between views

*  Swap two views by clicking and holding on one of the view
toolbars and dragging onto one of the other view toolbars
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Multiple Views: Linking the Camera of RenderViews

Renderview? (I [E]@)[X]

- Make Views comparative by
adding Camera Links:

» Right click on one of the
views over the background
-> Link Camera, then click
in the view to link with

» The two cameras are
linked, both draw the view
from the same viewpoint
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Comparative View

Visualize several representations of the same
scene, but with different parameters to make
parameter studies

» 0Open anew view and select
Render View (Comparative)

» Enable the comparative view inspector in the
View Menu

Choose a layout (e.g. 2x2)

Select the parameter(s) you want to vary
(upper panel)
> Adjust the parameter for the views (lower panel)

- Either click on one cell in the parameter
table, OR

- Select arange of cells and enter a
parameter range

March 16/17, 2022
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Comparative View Inspector

Layout: 2

&
-

X .2

% Contourl:Isosurfaces

Parameter

l@] [Cnntourl

- ”Isnsurfacu -

4 Contour 1:Isosurfaces

Comma-separated values accepted.,

0 400

1 7064383

A

E
489817

91315
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Comparative View

Example: Visualization of a contour with 4 different isovalues

[ Layout 21 x |.Laruut#2)( | +'\ (Comparative View Inspector 8 x
L E EEEE e 7 Exz B

|71 overlay all comparisons

Parameter

#  Contourlilsosurfaces

[ [contours ~ |[1s0surfaces

4 Contour1:Isosurfaces

Comma-separated values accepted.
A EB

0 10 366667

1 63.3333 90
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Plotting

* mechanism to drill down into your data to allow quantitative
analysis.

* Plots are usually created with filters (Filters->DataAnalysis)

 also: data analysis toolbar containing the most common data
analysis filters, some of which are used to generate plots.

Extract Location l]

o2 Plot Global Variables Over Time
| Plot Over Line
9| Plot Selection Over Time
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Plotting Example: Plot over a line in space

» Hit Plot Over Line from the Data Analysis Toolbar
* Place a Line Widget in the 3D space, hit Apply

* Choose the variables you would like to see in the Line Chart
View (in the Properties Panel, while Line Chart View and the
Plot Over Line filter are active!)

* Line plot allows for a e R R Sl IR BRG] e
different scale on the left and o e
right axis -> scale each

variable individually on each

axis.

» save the plot as a screenshot
(File-> Save Screenshot) or
export it to a vector graphics
that scales properly
(File->Export Scene).
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Text Annotation

* Use Text source to place some text in the 3D view
» Drag it with the mouse to the position you like

» Use the Display section of the property panel to change the
appearance of the Text (font, size, position, color)

° ParaVIGW SupportS -%ﬁ;&% ) J’J-‘ . & 1’ | K <D D D> D 5o =
e ; . e - L e R i o
MathText markup for 1$088905280 ~—-0O7 25
Pipe\vne‘BmWSE(‘ g% j“v:“:;x‘}‘*w. R Rendervien! (@)B)0)E
mathematical » g ' o
. . — 92 :i 3
expression rendering  |ee . | Volume /Twy il
r text @
= Properties (Text1) ‘@'

(See http://matplotlib.org/users/mathtext.ntml for details)
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Exercise V: Plotting

1. Creating a Plot Over Line:
— Opendisk_out_ref.ex2, load all variables

— Add a Clip filter, uncheck the Show Plane checkbox in the
Properties Panel, click apply

— Click on disc_out_ref.ex2 to make it the active object and
select the plot over line filter.

— Tryto position the line segment in 3D space
» try grabbing and moving the handles, the line itself,

G“K.\”

different mouse buttons, press “p” for picking a point
under the curser)

— Finally, hit the button “Z Axis” in the Properties panel, hit
apply
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Exercise V: Plotting (continued) -

Apply ) Reset % Delete
Search .., (use Esc to dear text)
T T—

2. Changing the display options é
— Make the plot view active and She  Eie |s
deselect all variables except for = %™ ©

Line Thickness 2

Line Style |Sol<d

Temp and Pres ol — 5
3

Chart Axes  [Bottom-Right

- SeleCt Pres Variable in the ‘=V'|ew{LineChart\c'\ew} |@@

Chart Title

Display options of the s

, ] (@B E
Properties panel R

LLLLL d Location |TopR.ight = ]

— Change the Chart Axis to S e

— Temp

Bottom-Right = =
— Add annotations to the left and '

right Axis (Temperature,

Pressure)

F0010

E 8 8 5§ 8 § 8 8 3 a 8
E &8 8 8 8 8 8 8 8 8 8
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Time in ParaView

» ParaView supports visualization of temporal data providing

* Readers for file series and datasets containing several
time steps

* Temporal filters, e.g.
» Annotate Time

> Temporal Interpolator (good for mesh deformations,
topology has to remain consistent!)

» Particle Tracer

* Toolbars: VCR Controls, Current Time Controls:
4 < > 0> Pl 55 | itmeo 0 [Z]ofid

* View -> Animation View: see next Slide
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Controlling Time: Animation View

Animation View g X
Mode: [Enap To Time5teps = |Time |0 Start Time: |0 E End Time: |0.004299358550 |§| Duration: | 10
Tirne 0.000e+00 1.433e-03 2.867e-03 4,300e-03
' 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

oo |EI‘|.E}(2 b | |Use Meta File b |
i

* Animation Mode: determines how ParaView steps through
time during playback

* Snap To TimeSteps: plays exactly those steps defined by
your data

» Sequence: Specified number of frames equally spaced
between start and end time

* Real Time: animation lasts approx. the specified number of
seconds

e Default: Snap to TimeSteps
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Exercise VI: Time Dependent Data

Open the file: can.ex2

Set the view direction to +y

Add an Annotate Time filter to observe time changes
Animate the mesh

Time: 0.000000 Time: 0.000500 Time: 0.004300
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Exercise VI: Time Dependent Data (cont.)

Split the view horizontally and apply the Temporal Interpolator
Filter to the data.

Select Real Time as animation mode, set duration to 30 seconds
Link the cameras .. ... co.e.
Hit Play

Renderiew! (I][B]@](x] & EDR B ol ROl RenderVien2 (M]B]@][x]

i i
Tirme: 0.001029 4o Time: 0.001029 P
Animation View [ 4
Mode:[RealTme = |Time3.00102867481311199 StartTime: (B3] End Tme: 0.0042593885049852 (23] Duration: 30
Time 000e+00 1,4336-03 2,867e-03 4,300e-03
[¥] TimeKeeperl - Time |

% [Temporaiinterpolator1 ¥ | Discrete Time Step Interval = |
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Exercise VII: Time Dependent Data, Comparative
View

* Reset the session and open the file can.ex2, enable all variables.
* Color the surface by VEL

* (Generate a comparative view with a 3x2 layout showing 6 different

time StepS. Olayout 22X | +
& W 30 B3 I DN Ep R B OB e | RenderViewComparativel [I)(E][0)[X]
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Animations

i O Layout #1 X .+.
PR - Renderviewl [m](E][0](x]

With ParaView, you can
animate

* Data time steps

* nearly any property of any
pipeline object

* The camera, to perform

camera flights along a e - T
.. . Mode: [Sequence - |Time 0.75 Start Time: 0 (&) End Time: 1 [£]No. Frames: 25
specified path or orbit. |
TimeKeeperl - Time
(] Use Python Scripts to % Slicel - Slice Type - Origin (1) [0 Pl 255
o & |slicet | islice Offset Values =
manipulate the scene every :
time step =t
March 16/17, 2022
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Animating Properties

» Select object and property from the combo boxes within the
Animation View, press #

» A new track is created, holding key frames that
specify values for the property at a specific time instance

Animation View g X
Mode: | Sequence = |Time 0,75 StartTime: 0 EEndTn'ne: 1 ElNo. Frames: 25

Time D.000e+00 5.000e-01 1.000e+00)
L e e o B

[¥] TimeKeeperl - Time

¥ [¥] Slicel - Slice Type - Origin (1) [0 & 255

Sicel | [Slice Offseth‘ah.:es‘—D
* Double-click at the new track to B Ariiation Keyhames e
edit the keyframes: Editing Slice 1 - Slice Type - Origin (1)

Tirme Interpolation  Walue Mew

21 255 | Delete Al
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Animating the camera

« Select “Camera” in the object #meve _ _ ?
. . Mode:lSequence ¥ |Time 0.75 StartTime: 0 |2|End Time: 1 IiJNo. Frames: 25
CO m b O bOX Wlt h I n th e Time J.DIUUEI+DIU o I5.IDIJIJIE-UI1 o 1.000e-+00

[7] TimeKeeperl - Time

Animation View.

#& [V Camera

’525‘ |Camera -

Fllnw
iFoIIow Data

* Choose one of the options: nipote s bt

> “Orbit” and “Follow Path” to create a (closed) spline widget
around your data along which the camera is animated

» “Follow Data” to look at the data in every step of the
animation.

» “Interpolate camera locations” to create a path between two
or more locations.

* Double-click at the new element to edit the keyframes

March 16/17, 2022 Folie 76



IJ JULICH

Forschungszentrum

Saving Screenshots and Animations =

M Save Screenshot Options

 File -> Save Screenshot B et e
« Save the current view(s) as — e E
PNG, BMP, TIFF, PPM, JPEG, PDF v ity 00 -y
* File -> Export Scene mm&u:m
- save your Image as a vector graphic comimere oot el ~
[No Steres =)
o [ coned |
* File -> Save Animations saves the current  [mic e T
animation as e el .
« 0Ogg/Theora (many open source viewers) i = g
AVI (windows, Some open source Viewers) mee oo F
- Sequence of JPEG, TIFF, PNG images | e o=

[Save Animaﬁon] I Cancel
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Exercise VIll: Animations

1. Animating Properties
—  Create a sphere from the Sources-Menu
— Animate the Start Theta property of the sphere from 0 to 360.
—  Set Number of Frames to 50.
— Save the animation as an AVl file.

JEEm

2. Modifying Animation Track Keyframes

—  Modify the animation track so that the sphere first becomes
smaller, from 360 to O degress, and them becomes greater O to
360 degrees
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Exercise Vlll: Animations (cont.)

3. Animating the camera
—  Create a Box from the Sources-Menu
— select “real time” as animation mode and 10 seconds duration
— Animate the camera in an orbit around your box
4.  Modify the key frames of the Orbit
— Open the key frame editor, double-click on “Path ...”
—  Select “Camera Position” in the Key Frame Interpolation Dialog
—  Modify the Spline Widget (now visible in the 3D view) in some way
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Visualizing Large Models

ParaView is meant for extremely large data processing:
Examples from Sandia National Lab in the web:

(about1 billion cells on 256 nodes)

* Visualizing extremely large data requires a big amount of resources
(especially memory)

» Use parallel visualization capabilities of ParaView

March 16/17, 2022 Folie 80



IJ JULICH

Forschungszentrum

Parallel ParaView

« ParaView has three main components:
— GUI (paraview)

— Data Server (pvdataserver) } Server (pvserver)
— Render Server (pvrenderserver)

Source Filter Data Server | Render Server |

Data Object Data Object

. Data Object
Data Object Data Object
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Parallel ParaView (continued)

- ParaView can be started in non parallel (standalone) mode:
» All three components in one single process
— command: paraview

Client

Data Render
Server Server
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Parallel ParaView (continued)

- ParaView can be started in two parallel modes:

1. Local client and parallel server
(data server and render server
In one JOb) Data Render

Server Server (el

— command on local client: paraview
— command on remote cluster:

mpiexec —n <NUM_pProcesses> pvserver
— connect client and server
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Parallel ParaView (continued)

2.

March 16/17, 2022

Local client and parallel data and render server
(data server and render server may run on different
machines)

— command on local client: paraview

— command on data processing server:
mpiexec -n <num_dataserver> pvdataserver
-m=machines.pvx
— command on render server:
mpiexec -n <num_renderserver> pvrenderserver
-m=machines.pvx

(num_dataserver >= num_renderserver)

Render
Server

Data

Sarvel — Client
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Parallel ParaView (continued)

Guideline;

» Cost of connecting data server and render server over TCP
sockets often overwhelms the benefit!

» run data server and render server in one process!

- Avoid X11 forwarding! (inefficient, lots of low level
communication underneath)

* Run client on desktop, NOT on login-node

e Or use Xpra+VirtualGL (mayby VNC) on login-node (our
recommendation)

Advantages of using Parallel ParaView:

* Local view on remote data: “File -> Open” shows you the data
server’s file system => big data may stay on the server!
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Data Distribution

Data needs to be distributed on a cluster (load balancing, memory
usage)

Some visualization algorithms work directly on distributed data, e.g.
clipping

<] e TE _1/ ([/
>

]

& _ | |

~ I NS EES -

| "

1

?/

i |
=
T~

-
l—
<

Other algorithms need ghost cells, e.g. external faces

g €<

partitioning and ghost

Structured data is handled automatically (
cells)

For unstructured data use the D3 filter

Example: extract surface filter with
and without D3:
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Memory Footprint

Memory footprint of structured data is MUCH lower than
unstructured data, because topology (and maybe geometry) is
implicitly given

Many filters need to convert structured data to unstructured
data: BEWARE OF DATA EXPLOSION!

— Examples: clip, threshold, ....., many, many others!

— Some filters reduce the dimensionality = less dangerous
Examples: contour, slice, stream tracer

“Save” filters just don’t change the data structure but only add
new data values (attributes)
Examples: calculator, gradient, curvature
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Remote Rendering

Server side rendering and
client side rendering possible:

server side rendering:
images are send to client

N

Storage

client side rendering:
graphical primitives are send
to the client

N

Client 2

Cluster
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Remote Rendering (Parallel Rendering)

*  Depth Compositing: All nodes will render their own part of the data
(local data)

* Nodes cooperate to decide what the color of each pixel is based
on the depth value

* Implemented with the ICE-T compositing lib
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Remote Rendering

Recommended settings for Remote Rendering, see
https://docs.paraview.org/en/latest/ReferenceManual/parallelData
Visualization.html#parallel-render-parameters

Edit -> Settings -> Render View -> Remote/Parallel Rendering
Options:
» Remote render threshold: set the data size beyond which to
render the data remotely

» Still Render Image Reduction Factor: image subsampling
for still rendering
 Edit -> Settings -> Render View -> Client/Server Rendering
Options:
* Image Reduction Factor: image subsampling for interactive
rendering

* Image Compression: LZ4, Squirt or Zlib for image
compression
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Visualization at JSC J AL
JUWELS: General Hardware Setup

4 x Visualization Login Nodes
= juwelsvis.fz-juelich.de

= (juwelsvis0O0 to juwelsvisO3 in
round-robin fashion)

= 768 GB RAM each

= 1 GPUs Nvidia Pascal P100 per node
= 12 GB RAM on GPU

No specific Visualization Batch Nodes

Keep in mind:
Visualization is NOT limited to vis. nodes ONLY.
(software rendering is possible on any node)
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General Setup
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Remote 3D Visualization

Users Workstation

|Keyboard || Mouse ” Screen

ParaView
Viewer
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120 ]]:]» <

Firewall

ssh + tunnel
(ParaView: port
11111)
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Remote 3D Visualization
at Julich Supercomputing Centre

= X forwarding + Indirect Rendering
slow, maybe incompatible - bad idea

* “remote aware” visualization apps (ParaView, Vislt)
application dependent, error-prone setup

= Xpra - stream application content with H.264 + VirtualGL
fast, our recommendation - good idea

= VNC (Virtual Network Computing) + VirtualGL
full remote desktop, but slower than Xpra - medium good
idea
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Remote 3D Visualization J JUL'CH
with Xpra (or VNC) + VirtualGL

= X-applications forwarded by Xpra (or VNC) appear on the local desktop as normal
windows
= allows disconnection and reconnection without disrupting the forwarded application

» advantages
. on user’s workstation (X display on server).
. on user’s workstation (only images are send).
= Quality of visualization does on user’s workstation.
» Data size send is from data of 3d scene.
= Disconnection and reconnection possible.
» VirtualGL for hardware accelerated rendering: use vglrun <application>
= it function calls from the application and
» The corresponding GLX commands are then sent to the X display of
, which has a 3D hardware accelerator attached.

» Good solution for any OpenGL application e.g. ParaView, Vislt, IDL, VMD, PyMol, ...
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Xpra Integration in JupyterLab@JSC

» How to start Xpra-Session:
= At JSC: Within JupyterLab@JSC https://jupyter-jsc.fz-juelich.de

JOLICH
SUPERCOMPUTING
CENTRE

uuuuuuuuuuuuuuu

Start  Links

» JUPYTERHUB

Serving Jupyter Notebooks for Multiple Users

We are pleased to bring "Supercomputing in Your browser”. Jupyter-JSC is a
JupyterHub to serve Jupyter notebooks for multiple users. It can be used in
classes of students, a corporate data science group or scientific research group.
It is a multi-user hub that spawns, manages, and proxies multiple instances of the
single-user Jupyter notebook server. Read more

- — = = = = —
& Jupyter-JSC = JUWELS == JURECA = JUSUF =— DEEP = HDFML ==— HDF-Cloud
~ = = = — =R =

© Forschungszentrum Jilich  Imprint  Privacy Policy ~ Support  Terms of Service
HELMHOLTZ
RESEARCH FOR GRAND CHALLENGES

= Alternative: start session manually, see next slides
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Remote 3D Visualization
with Xpra + VirtualGL

Firewall

Users
Workstation
HowTo start an Xpra session
SSH to HPC system, authenticate via SSH key pair

Load modules and start an application via Xpra.

E.g. start an xterm:
Xpra start --start=xterm

Look at the output and note the display number,
e.g. ,Actual display used: :3°

start local Xpra client and connect to remote display
Start visualization application in the xterm
Stop the Xpra session by xpra stop :3
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Setup Xpra
Step 1: login to a (visualization) login node

Linux:
ssh <USERID>@juwelsvis02.fz-juelich.de

Windows:
connect via a ssh client, e.g. PUTTY. The PuTTY ssh keyagent
pageant may be usefull, too.
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Step 2: start xpra on HPC node and notice the display-
number in the output

For example, start an xterm:

Jwvis(02>
Jwvis(02>

Jwvis(02>
3.8.5

Jwvis(02>

module —--force purge
module use otherstages
ml Stages/Devel-2020 GCCcore/.9.3.0 xpra/4.0.4-Python-

Xpra start —--start=xterm

Actual display used: :3

The display-number is needed to connect to the Xpra session
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Step 3: connect to Xpra session

Install Xpra on your local machine. Download from
WWW.Xpra.org

Linux: use command

local machine> xpra attach
ssh://USERNAME@juwelsvis02.fz-Jjuelich.de/3

Ve Session Launcher = o 4

Windows: use Xpra GUI:

Connect to xpra server

i Xpra - a] % Mode:  55H w

[r—

Server: | zilkenl @ juwelsvisD2.fz-juelich.de 22 :
e i ]
i§j Connect

/ Browse

-
—"— Shadow

ave C
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Setup Xpra

Step 4: start visualization application

After successful connection, an xterm window will show up on your local
desktop.

Start your application there, e.g. ParaView:

L3 zilken1@jpwvis02:~/bin on juwelsvis02.fz-juelich.de — O >

[zilkenl@juwvis0?2 binlt module ——Force purge
[zilkenlBjwwi=0Z binl$ ml Stages/2020 GCCA9,3,0 ParaStationMPIA9,.4,.7-1
Preparing the envirorment for use of requested stage [ 2020 3,

[zilkenl®jwei=0Z binl$ ml FaraView/5.8,1-Python-3,8.5
[zilkenl@juvis02 binlt volrun paraview
[zilkenl@jwwiz0? binl$ ]

Step 5: When you are done, stop the session by
Jwvis(02> xpra stop :3
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ParaView Python Scripting

« ParaView can be fully controlled by a Python script

Reasons to do this:

« For batch processing of data (many files, many time steps,
many different visualization methods)

« To store and reconstruct (and to document) the state of a
(complex) ParaView pipeline
* As a workaround for some ParaView flaws

* e.g. memory leak when loading time steps:
close and restart ParaView every N frames (just to clear
the memory) and let the script resume the animation
exactly at that point
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ParaView Python Scripting

Some useful links:

* https://www.paraview.org/Wiki/ParaView/Python_Scripting

* https://kitware.github.io/paraview-
docs/latest/python/paraview.simple.html

* https://trac.version.fz-
juelich.de/vis/wiki/Examples/ParaviewAnimating

* https://trac.version.fz-juelich.de/vis/wiki/Examples/EarSAnimating
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ParaView Python Scripting: How To

 The GUI is a good tool to prototype the scene, especially
pipeline properties, color tables and camera positions

« Automated facility for creating Python scripts: Tracing

« Tools -> Start Trace to begin trace recordlng,
Tools -> Stop Trace to end it

* Produces a python script that
reconstructs many (not all ®)
actions performed in the GUI

« Script can be started by
pvpython ./script.py

* Images can be saved by
SaveScreenshot (,,./foo.jpg", renderView,
ImageResolution=[1920,1080])
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From Gui To Script

« Color tables can be saved in the GUI and loaded in the script
by

ImportPresets ('colortable.json')

« (Camera positions can also be saved in an xml file and loaded
in the script by

import xml.etree.ElementTree as ET
from paraview.simple import *

def assignCameraParameters (root, camera, camlIdx):

camera.SetPosition( (root[camIdx-1][1]1[0][0]1[0]1[0].attrib['value']), (root[camIdx-
1][1][0][0][0][1].attrib['value']), (root[camIdx-1][1]1[0][0][0][2].attrib['value']))
camera.SetFocalPoint ( (root[camIdx-1][1][0][0][1][0].attrib['value']l), (root[camIdx-
1][1][0][0][1]1[1].attrib['value']), root[camIdx-1][1][0][0][1][2].attrib['value']))
camera.SetViewUp ( (root[camIdx-1][1]1[0][0][2][0].attrib['value']), (root[camIdx-
1][1][0]([0]1[2][1].attrib['value']), (root[camIdx-1][1]1[0][0][2][2].attrib['value']))
camera.SetParallelScale((root[camIdx-1][1][0]1[0][6][0].attrib['value']))

tree = ET.parse('camera.pvcvbc')
camera = GetActiveCamera ()
assignCameraParameters (tree.getroot (), camera, 1)
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Macros

- Scripts can by used as a Macro (=automated script)

Macros can be invoked from the Menu Button Macros or
directly inside the toolbar by clicking on it.

* View and customize macros within the Macro Menu:

* edit, delete existing macros,

 add new macros (load python scripts from file system)
» Use Macros for:

» Creating data from scratch

 Applying filters to existing data (to automate the same
visualization on different data)
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pvpython and pvbatch

« Command line programs that execute Python scripts

* Feeding scripts from command line or file to the python
interpreter

* pvpython:
* serial program

* equivalent to the GUI-Client, replacing the GUI with the
python interpreter

* pvbatch:
« parallel application, can be launched with mpirun
* runs without user interaction, saves images to disk
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ParaView Python Scripting - basic bindings

* First thing any ParaView Python script must do is load the
paraview.simple module: from paraview.simple import *

* Automatically invoked in the scripting dialog in ParaView
(Tools->Python Shell)

MY Python Shell 2 &=

hon 2_7.8 {default, Sep £3 2014, Z0:23:11) [M5C
! 4 bit (AMDE4) ] on win3z

>»» from paraview.simple import *

» Add it yourself when writing | =
script from scratch

- paraview.simple defines
convenient functions for Rensaript | [ cear || Reset [ cese |

* Sources * Filters
 Readers  Writers
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ParaView Python Scripting - functions

Have the same name as shown in the GUI menus, but spaces
and special characters removed:

* Sphere = Sources->Sphere
* PlotOverLine = Filters->Data Analysis->Plot Over Line

» Create a pipeline object that shows up in the pipeline browser
(except for writers)

* Return an object that can be used to query and manipulate
properties

 List of functions available in paraview.simple:
e dir(paraview.simple)
* help(paraview.simple) -> verbose listing

Example: https://trac.version.fz-
Juelich.de/vis/wiki/Examples/Brain
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Python Scripting - Simple Example

Creating and showing a source

from paraview.simple import * needs to be invoked at the
beginning of any ParaView Python script

import os generated Output will be

os.chdir(“path_to directory”) written to the specified path

sphere = Sphere() create a sphere pipeline object
Show() turn on visibility of this object
Render() cause results to be seen in the view

WriteImage("testl.png") create an output
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Python Scripting - Simple Example

Creating and Showing a Filter

Hide() hides the sphere

shrink=Shrink() adds a Shrink Filter to the sphere
Show() and shows that

Render() Shrink Filter makes all the polygons
WriteImage("test2.png") smaller and give the mesh an

exploded type of appearance
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Python Scripting - Simple Example

Changing pipeline object properties

help(sphere)

print sphere.ThetaResolution

sphere.ThetaResolution=16
Render ()

WriteImage("test3.png")

print shrink.ShrinkFactor
shrink.ShrinkFactor=0.25
Render ()

WriteImage("test4.png")

March 16/17, 2022

get a full list of properties

print current value of theta resolution
(=8)

set it to a new value
turn on visibility
create an output

print current ShrinkFactor
set it to a smaller value
turns on visibility
create an output
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Python Scripting - Simple Example
Branching Pipelines

wireframe=ExtractEdges(Input=sphere) add a second filter to the

Show( ) sphere source

Render()
WriteImage("test5.png")

Note: Any action is performed to the active object

» get/set active object via GetActiveSource/SetActiveSource
functions

« Set the Input property upon construction of an object to by-
pass this behavior
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Exercise IX: Create a Python Script and run it
Create a Python script by tracing ParaView:

— Create a Sphere Source with ThetaResolution=20, hit
apply
— Apply the Extract Edges filter to the sphere
— Save a screenshot
» Testthe script as a macro

» Test the script with pvpython
(Note: you have to edit the script and

add the “Connect()” command at the
beginning)
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Loading Data with Programmable Source

Example: load csv data.

Input files: .csv (text) files with naming scheme
TOAR_YYYYMMDD_HHMM.csv

Content: latitude, longitude, value, of an unconnected “point

cloud” e.g.:
8.3082,
12.7253,
.0939,
.5484,
.8746,
.9769,
4575,

~J O O O O
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4367,
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52.
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.5200,
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28
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Loading Data with Programmable Source

Request Information Script:
def setOutputTimesteps (algorithm, timesteps):

"""helper routine to set timestep information"""
executive= algorithm.GetExecutive ()
outInfo = executive.GetOutputInformation (0)

outInfo.Remove (executive.TIME STEPS())
for timestep in timesteps:
outInfo.Append (executive.TIME STEPS(), timestep)

outInfo.Remove (executive.TIME RANGE ())

outInfo.Append (executive.TIME RANGE (), timesteps[0])
outInfo.Append (executive.TIME RANGE (), timesteps[-1])
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Loading Data with Programmable Source

Request Information Script (continued)
def getFilelList (fpath, fprefix, fpostfix):
"""get all files"""
import os
files=][]
for i in os.listdir (fpath):
if os.path.isfile(os.path.join (fpath,i)) \
and fprefix in i \
and fpostfix in i:
files.append (i)
files.sort ()

return files

def getTimeTuple (fname, fprefix, fpostfix):

"""get timetuple from file name"""

import time

import datetime

ftime str = fname[len(fprefix) :-len(fpostfix)]
ftimetuple =
time.mktime (datetime.datetime.strptime (ftime str,"3Ysm3d SHSM") .timetuple())

return ftimetuple
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Loading Data with Programmable Source

Request Information Script (continued)
def getTimestepsFromFiles (files, fprefix, fpostfix):

"""generate timestap from filename"™"
ref ftime = 0.0
ftime sec = []
for i, fname in enumerate (files):
cur ftime = getTimeTuple (fname, fprefix, fpostfix)
if 1 == 0:
ref ftime = cur ftime
ftime sec.append(cur ftime -ref ftime)
ftime h = [ x / 3600 for x in ftime sec ]
ftime h int = [int (1) for 1 in ftime h]

return ftime_h_int
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Loading Data with Programmable Source

Request Information Script (continued)

# get all files

fpath="/data/30-Projekte/2018-03-
12 TagDerWissenschaft/m.schultz/"

fprefix="TOAR "
fpostfix=".csv"

files = getFilelList (fpath, fprefix, fpostfix)
timestamps = getTimestepsFromFiles (files, fprefix, fpostfix)

# get time-steps
setOutputTimesteps (self, timestamps)
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Loading Data with Programmable Source

Main Script

def GetUpdateTimestep(algorithm) :

"""Returns the requested time value, or None 1f not
present."""

executive = algorithm.GetExecutive ()
outInfo = executive.GetOutputInformation (0)
return outInfo.Get (executive.UPDATE TIME STEP()) \

if outInfo.Has (executive.UPDATE TIME STEP()) else
None

*** getFilelList, getTimeTupe, getTimestepsFromFiles as above
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Loading Data with Programmable Source

Main Script (continued)
def getFileFromTimestep (tstep, fpath, fprefix, fpostfix):

"""generate filename for time-step"""

import time

import datetime

files = getFilelist (fpath, fprefix, fpostfix)
timestamps = getTimestepsFromFiles (files, fprefix, fpostfix)
# get a tstep, which we have data for

ret tstep = min(timestamps, key=lambda x:abs (x-tstep))
# get date-string from tstep

ref ftime = getTimeTuple (files[0], fprefix, fpostfix)
ftimetuple = time.localtime (ref ftime + ret tstep*3600)
tstr = time.strftime ("%$YSm%d $HIM", ftimetuple)

# create filename

ret fname = fpath + fprefix + tstr + fpostfix

return ret tstep, ret fname
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Loading Data with Programmable Source

Main Script (continued)
def readCSVFile (fname, output):

import math

import csv

import vtk

newPts = vtk.vtkPoints ()

valArray = vtk.vtkDoubleArray ()
valArray.SetName ('Ozone')
valArray.SetNumberOfComponents (1)
# fill VTK objects

with open (fname) as csvfile:

csvReader = csv.reader (csvfile, delimiter="',")
numPts = sum(l for row in csvReader)
i =0

csviile.seek (0)
for row in csvReader:
# read row
# longitude, latitude, (ozone) value [letzterer in nmol mol-
1]
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Loading Data with Programmable Source

Main Script (continued)

lon = float (row[0])
lat = float(row[l])
val = float(row[2])

# convert longitude,latitude,altitude to x,vy,z

# spherical coordinates to cartesian coordinates on a unit
sphere (radius=1)

radTmp = math.cos (lat);

z = math.sin(lat);

x = math.cos(lon +1.5*math.pi) *radTmp;
y = math.sin(lon +1.5*math.pi) *radTmp;

i =i+l
newPts.InsertPoint (i-1, x,y,2z)

valArray.InsertValue (i-1, wval)

output.SetPoints (newPts)
output.GetPointData () .AddArray (valArray)
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Loading Data with Programmable Source

Main Script (continued)

# req time is the requested time-step.

# This may not be exactly equal to the time-step published in
RequestInformation() (the code must handle that)

req time = GetUpdateTimestep (self)

# Use req time to determine which CSV file to read
fpath="/data/30-Projekte/2018-03-12 TagDerWissenschaft/m.schultz/"
fprefix="TOAR "

fpostfix=".csv"

ret time, ret fname = getFileFromTimestep (req time, fpath, fprefix,
fpostfix)

# read CSV file
#pdo = self.GetPolyDataOutput ()
readCSVFile (ret fname, output)

# Mark the time-step produced
output.GetInformation() .Set (output.DATA TIME STEP(), ret time)
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ParaView Plugins - Introduction

https:.//www.paraview.org/Wiki/ParaView/Plugin_HowTo

ParaView comes with a large range of readers, filters and
views providing a large range of functionality

ParaView provides an extensive plugin mechanism which
enables the user to

add new readers, writers and filters

add custom GUI components such as toolbar buttons to
perform common tasks

add new views for displaying data
The following slides cover
how to use existing plugins
how to write new plugins for ParaView.
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Using ParaView Plugins

Plugins are distributed as shared libraries (*.so on Unix, *.dylib on
Mac, *.dll on Windows)

Plugin must be built with the same version of ParaView
ParaView has to be built with shared libs enabled

three ways for loading plugins:
using environment variable PV_PLUGIN_PATH (Auto-loading plugins)
placing the plugins in a recognized location:

- “plugins” subdirectory beneath the directory containing the
paraview client or server executables

- “plugins” subdirectory in the user's home area.

SHOME/.config/ParaView/ParaView<version>/Plugins on
Unix/Linux/Mac

%APPDATA%\ParaView\ParaView<version>\Plugins on
Windows

using the GUI
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Loading ParaView Plugins Using the GUI

- Plugin manager accessible from Tools | Manage Plugins
menu:

|1

M Plugin Manager 2 &

Local plugins are automatically searched for in C:\Users\Habbinga\AppData'Roaming/ParaView ParaView Plugins.

Remote Plugins Local Plugins
MName  Property MName Property
i NIFTIWriter Mot Loaded
i MIfTIReader Mot Loaded
I AnalyzeWriter Mot Loaded
AnalyzeReader Mot Loaded
VisTrailsPlugin Mot Loaded
H5PartReader Mot Loaded
VRPMPlugin Mot Loaded
I SurfacellC Mot Loaded
i+ StreamingView Mot Loaded
- SLACTools Mot Loaded
I» SierraPlotTools Mot Loaded
pvblot Mot Loaded

PointSprite_Plugin Mot Loaded
PrismClientPlugin Mot Loaded
Prism5erverPlugin Mot Loaded
Moments Mot Loaded
EyeDomelightingView Mot Loaded

v W

Load New ... | |Load Selected Remave Load Selected Remave

=
|
b
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Writing ParaView Plugins -

Server Manager Configuration

ParaView uses the VTK Server Manager for building distributed
client-server applications by means of the Proxy design pattern

Proxies are defined in the Server Manager Configuration XML
Proxies are organized in ProxyGroups
Examples: sources, filters, views, ...

Each Proxy stores a reference to the corresponding VTK object
located on the server

Examples: SourceProxy, ViewProxy, ...

The Proxy contains Properties to describe the part of the interface
which is exposed to the client (function name and arguments)

Examples: IntVectorProperty, StringVectorProperty,
InputProperty, ...

The range of values of a property can be restricted by Domains

Examples: IntRangeDomain, FileListDomain, DataTypeDomain,
ProxyGroupDomain,...
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Enabling existing VTK-Classes as Plugins

- To enable an existing VTK-class, write a Server Manager
configuration xml-file and load it into the ParaView GUI

- example: enable the VTK-filter vtkCellDerivatives, write
CellDerivatives.xml as follows

<?xml version="1.0"?>
<ServerManagerConfiguration>
<ProxyGroup name=,filters“>
<SourceProxy name=,MyCellDerivatives“ class=,vtkCellDerivatives* |label=,My Cell Derivatives“>
<Documentation
long_help=,Create point attribute array by projecting points onto an elevation vector.*

short_help=,Create a point array representing elevation.“>
</Documentation>

<InputProperty
name=,Input”
command=,SetinputConnection“>
<ProxyGroupDomain name=,groups“>
<Group name=,sources”/>
<Group names=,filters“/>
</ProxyGroupDomain>
<DataTypeDomain name=,input_type“>
<DataType value=,vtkDataSet"/>
</DataTypeDomain>
</InputProperty>
</SourceProxy>
</ProxyGroup>
</ServerManagerConfiguration>
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Writing New ParaView Plugins - Source Code

Compiling plugins requires own build of ParaView since binaries
downloaded from www.paraview.org do not include necessary header
files

Example: simple reader called vtkCSVImageReader
read a 2D image from a text file with simple delimited format

allow someone to export simple matrices of data from Excel and
visualize them as heat maps or height fields in ParaView

assume the files consist of strictly numeric values separated by
commas or some other delimiter

use a vtkDelimitedTextReader instance which will read delimited
text into a vtkTable

methods to set and get the file name and field delimiter characters,
which are delegated to the vtkDelimitedTextReader instance
variable
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Writing New ParaView Plugins

Writing a new plugin requires generating the following files:
.cxx and .h files (the actual plugin source code)
Server manager configuration (xml-file)
configuration xml for the GUI (optional for filters)

CMakelLists.txt for compiling your source code into a shared
library

Hint: try to find similar plugin in the ParaView sourcecode
(src/Plugins, src/Examples/Plugins)

Use this code as a starting point
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Writing New ParaView Plugins -
Source Code

Step 1: override the following methods of the chosen vtk superclass
to make it operate properly in a standard vtk pipeline:

tell the VTK pipeline information about the data before creating
the output, e.g. extent, spacing and origin in case of
vtklmageData

int vikCSVImageReader::Requestinformation( vtkinformation *request,

vtkInformationVector **inputVector,
vtkinformationVector “outputVector)

read data from the file and store it in the corresponding data
object in the output port

int vikCSVImageReader::RequestData( vtkinformation *request,
vtkInformationVector **inputVector,
vtkInformationVector *outputVector );

Step 2: override other methods, e.g. SetFileName(const char*
fname), SetFieldDelimiterCharacters(const char* delim), ...
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Class vtkCSVimageReader

class vtkCSVImageReader : public vtkimageAlgorithm

{

public:
static vtkCSVImageReader* New();
vtkTypeRevisionMacro(vtkCSVImageReader,vtkimageAlgorithm);
void PrintSelf(ostream& os, vtkindent indent);
virtual void SetFileName(const char* fname);
virtual const char* GetFileName();
virtual void SetFieldDelimiterCharacters(const char* delim);
virtual const char* GetFieldDelimiterCharacters();

protected:
vtkCSVImageReader();
~vtkCSVImageReader();

int Requestinformation(vtkinformation*, vtkinformationVector**,
vtkinformationVector*);

int RequestData(vtkinformation*, vtkinformationVector**, vtkinformationVector*);

vtkDelimitedTextReader* Reader;

private:
vtkCSVImageReader(const vtkCSVImageReader&);
void operator=(const vtkCSVImageReader&); };
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Requestinformation(...)

int vtkCSVImageReader::Requestinformation (vtkinformation*, vtkinformationVector**,
vtkInformationVector* outputVector)
{
vtkinformation* outinfo =outputVector->GetIinformationObject(0);
this->Reader->Update();
vtkTable* output = this->Reader->GetOutput();
vtkldType rows = output->GetNumberOfRows();
vtkldType columns = output->GetNumberOfColumns();

int ext[6] = {0, rows, 0, columns, 0, O};
double spacing[3] ={1, 1, 1};
double origin[3] = {0, 0, 0};

outInfo->Set(vtkStreamingDemandDrivenPipeline:WHOLE_EXTENT(), ext, 6);
outinfo->Set(vtkDataObject::SPACING(), spacing, 3);
outinfo->Set(vtkDataObject::ORIGIN(), origin, 3);
vtkDataObject::SetPointDataActiveScalarinfo(outinfo, VTK_FLOAT, 1);

return 1;
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RequestData(...)

int vtkCSVImageReader::RequestData(vtkinformation*, vtkinformationVector**,
vtkinformationVector* outputVector)
{
vtkimageData* image = vtkimageData::GetData(outputVector);
vtkTable* output = this->Reader->GetOutput();
vtkldType rows = output->GetNumberOfRows();
vtkldType columns = output->GetNumberOfColumns();
image->SetDimensions(rows, columns, 1);
image->AllocateScalars();
vtkDataArray* scalars = image->GetPointData()->GetScalars();
scalars->SetName(“Data”);
for (vtkldType r = 0; r < rows; ++r)
{
for (vtkldType ¢ = 0; ¢ < columns; ++c)
{
vtkVariant val = output->GetValue(r, c);
float f = val.ToFloat();
scalars->SetTuplel(c*rows +r, f);
}
}

return 1;

}
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Writing New ParaView Plugins -

Server Manager Configuration
- Server Manager Configuration for the example CSVImageReader:

<?xml version="1.0"?>
<ServerManagerConfiguration>
<l— Begin CSVImageReader -->
<ProxyGroup name=,sources>
<SourceProxy name=,CSVImageReader"
class=,vtkCSViImageReader">
<StringVectorProperty name=,FileName*
number_of elements=,1“
command=,SetFileName“>
<FileListDomain name=,files“/>
</StringVectorProperty>
<StringVectorProperty
name="“FieldDelimiterCharacters”
command="SetFieldDelimiterCharacters”
number_of elements="1"
default_values=","/>
</SourceProxy>
</ProxyGroup>
<!l— End CSVImageReader -->
</ServerManagerConfiguration>
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Writing New ParaView Plugins - Configuration XML
for the GUI

Provides the higher-level information about where new elements
will be placed in the user interface.

Example: CSVImageReaderGUIl.xml

<?xml version="1.0"?>
<ParaViewReaders>
<Reader
name=,CSVImageReader"
extensions=,csvimg*

file_description=,csv Image data“>
</Reader>
</ParaViewReaders>

tells ParaView to create GUl elements for “CSVImageReader”

creates a new entry in the File Open dialog for CSV image data
files

associates files ending in “.csvimg” with the new reader
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Writing ParaView plugins - CMakeLists.txt

Use cmake to build the ParaView plugin
CMakelLists.txt file ties sources and xml files together

CMAKE_MINIMUM_REQUIRED(VERSION 2.6)
PROJECT(CSVImageReader)

FIND_PACKAGE(ParaView REQUIRED)
INCLUDE(${PARAVIEW_USE_FILE})

ADD_PARAVIEW_PLUGIN(CSVImageReader "1.0"
SERVER_MANAGER_XML CSVImageReader.xml

SERVER_MANAGER_SOURCES vtkCSVImageReader.cxx
GUI_RESOURCE_FILES CSVImageReaderGUIl.xml)

locate ParaView with FIND_PACKAGE

import the CMake configuration parameters from ParaView by
including PARAVIEW _USE_FILE.

ADD_PARAVIEW_PLUGIN specifies all the information needed
to build the plugin.
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Documentation

The Paraview User’s Guide
The Visualization Toolkit
The VTK Guide

Mastering Cmake

All are published by Kitware, Inc.
iij":gig\w!iew Guide I

M Mastering CMake I

A Cross-Platbem Build Syslem

alization Application

Chduie 31

Sflron 1T

Wil Sehroeder
Hen Metfin
Bill Lorensen

- tkarsh Agachit
W kitware 8 et e lhwed Al

LR

Specid Conebiars
Loa S e, ck Ao, €. Crton Law

ParaView Guide (Community Edition), Getting Started and Tutorial (pdf) are
included in ParaView download
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ParaView Links

ParaView Homepage: http://www.paraview.org
ParaView Wiki: http://www.paraview.org/Wiki/ParaView
* Importing Data

* Extending Paraview

« ParaView Server Setup
* Tutorials

ParaView Documentation:
https://www.paraview.org/documentation/

ParaView User Guide:
https://docs.paraview.org/en/latest/UsersGuide/index.html

ParaView Forum (since Oct. 2018): https://discourse.paraview.org/

Link to (no longer supported) mailing list, can be useful to search old posts:
https://www.paraview.org/community-support/
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